
www.ijcrt.org                                                           © 2023 IJCRT | Volume 11, Issue 5 May 2023 | ISSN: 2320-2882 

IJCRT23A5156 International Journal of Creative Research Thoughts (IJCRT) www.ijcrt.org j579 
 

Novel Emergency Message Dissemination Scheme For 

Urban Vanets 
 

1 Prof. Pramod G. Patil 

2Kritika Nandani    3Unnati .   4Tulika Sharma   5Priyanka Kamble 

Department Of Computer Engineering Of Sandip Institute Of Technology And Research Centre , Nashik  

 

Abstract: In VANETs, significant challenges are faced, while disseminating the message across the network. The major challenges are the 

broadcast storm problem, hidden node problem, and packet collisions. We propose an Effective Emergency Message Dissemination Scheme 

(EEMDS) for urban VANETs. The scheme is grounded on our mobility metrics to escape communication outflow and to maintain the stability 

of the cluster structure. Every vehicle takes into account its direction and path loss factor for opting appropriate cluster head. Also, we introduce 

estimated link stability to choose a suitable dependent vehicle (an intermediary that communicates between multiple clusters) that reduces the 

number of retransmits and communication traffic in the network. Simulation results covey that NEMDS provides an acceptable end-to-end 

detention, information coverage, & packet delivery ratio compared to the eminent Emergency Messages dissemination schemes. 

 

Introduction  
 

Urban VANETs are wireless networks formed by vehicles 

and roadside units (RSUs) in urban environments. These 

networks enable vehicles to exchange information, 

including traffic updates, safety warnings, and emergency 

messages. In emergency situations, disseminating messages 

to all vehicles becomes critical to ensure that timely action 

can be taken. However, several challenges arise when it 

comes to efficient emergency message dissemination in 

urban VANETs. 

 

Challenges in Emergency Message 

Dissemination in Urban VANETs High 

vehicular density:  
 
Urban areas are characterized by heavy traffic, resulting in a 

large number of vehicles in close proximity. Traditional 

flooding-based approaches may lead to excessive message 

overhead and congestion. Frequent topology changes: 

Vehicles in urban areas often experience frequent changes 

in their relative positions and connectivity due to 

intersections, traffic lights, and varying traffic patterns. This 

dynamic topology makes it challenging to establish reliable 

communication paths. Limited communication range: The 

communication range of vehicles is constrained by factors 

such as signal interference, obstacles, and radio propagation 

conditions. This limited range restricts the dissemination of 

emergency messages beyond a certain distance.  

 

Existing Solutions for Emergency Message 
Dissemination Several approaches have been proposed to 

address the challenges of emergency message dissemination 

in urban VANETs. These include flooding-based 

approaches, geocaching techniques, and cluster-based 

schemes. Flooding-based approaches: Flooding involves 

broadcasting messages to all neighboring vehicles in the 

hope that they will relay the messages further. While 

simple, flooding suffers from high redundancy and 

broadcast storm problems. Geocasting techniques: 

Geocaching is a targeted broadcasting technique that aims to 

limit message dissemination to a specific geographic area. 

However, it may still suffer from high overhead and limited 

coverage. Cluster-based schemes: Cluster-based schemes 

organize vehicles into clusters, with one or more cluster 

heads responsible for disseminating messages within their 

respective clusters. However, maintaining cluster stability 

and dealing with overlapping clusters pose challenges. 

 

 Proposed Scheme: Intelligent Routing for 

Emergency  
 

Message Dissemination To overcome the limitations of 

existing approaches, we propose an intelligent routing 

scheme for emergency message dissemination in urban 

VANETs. This scheme leverages real-time vehicular traffic 

information and employs a predictive routing algorithm 

along with an adaptive message-forwarding strategy. By 

utilizing vehicular traffic information, the proposed scheme 

can identify areas with high congestion or traffic density. It 

dynamically selects the most suitable and least congested 

routes for message dissemination, reducing unnecessary 

message replication and optimizing network resources. The 

predictive routing algorithm takes into account the current 

vehicle positions, traffic patterns, and estimated future 

positions to predict the most likely paths that vehicles will 

take. This proactive approach ensures that emergency 

messages are delivered to vehicles even before they enter an 

affected area. Moreover, the scheme incorporates an 

adaptive message-forwarding strategy that adjusts the 

message transmission range based on the density of nearby 

vehicles. In areas with high vehicular density, the 

transmission range is reduced to mitigate congestion, while 

in sparsely populated areas, it is increased to ensure wider 

coverage. 
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 Literature Review  
 
The literature review section provides an overview of 

existing research and literature on emergency message 

dissemination schemes in VANETs. It explores the 

evolution of this field, identifies relevant studies, and 

discusses the key advancements, limitations, and research 

gaps. Additionally, it delves into the technologies and 

protocols used in VANETs for communication and message 

dissemination. Evolution of Emergency Message 

Dissemination Schemes in VANETs This subsection traces 

the evolution of emergency message dissemination schemes 

in VANETs, from early studies to recent advancements. It 

highlights seminal research papers and projects that have 

contributed to the development of this field. The discussion 

encompasses different approaches, including centralized, 

decentralized, and hybrid schemes, and their suitability in 

urban environments. 

 

Existing Emergency Message Dissemination 

Schemes  
This section presents an overview of existing emergency 

message dissemination schemes in VANETs. It discusses 

the characteristics, mechanisms, and protocols employed in 

these schemes, focusing on their strengths and weaknesses. 

Various approaches such as flooding-based, beacon-based, 

and multi-hop routing schemes are examined, along with 

their application in urban scenarios. 

 

 Limitations and Research Gaps  

 
This subsection addresses the limitations and research gaps 

identified in current emergency message dissemination 

schemes. Common limitations may include high message 

overhead, scalability issues, limited coverage, and 

vulnerability to attacks. The discussion emphasizes the need 

for more efficient and robust schemes that can handle the 

unique challenges of urban environments, such as high 

vehicle density and dynamic mobility patterns. 

 
Technologies and Protocols  
 
in VANETs This section explores the technologies and 

protocols used in VANETs for communication and message 

dissemination. It covers Wireless Access in Vehicular 

Environments (WAVE) standards, Dedicated Short-Range 

Communications (DSRC), IEEE 802.11p, and Cellular 

Vehicle-to-Everything (C-V2X) communication 

technologies. The discussion also includes protocols like the 

Ad hoc On-demand Distance Vector (AODV), Dynamic 

Source Routing (DSR), and Geographical Routing protocols 

commonly used in VANETs.  

 

Literature Review Conclusion  

 
The literature review provides an overview of the existing 

literature and research on emergency message dissemination 

schemes in VANETs. It highlights the evolution of this 

field, discusses the limitations and research gaps in current 

approaches, and explores the technologies and protocols 

used for communication and message dissemination in 

VANETs. The review underscores the need for more 

efficient and robust schemes that can handle the specific 

challenges of urban environments. By identifying the gaps 

and limitations, this study aims to contribute to the 

development of novel and effective emergency message 

dissemination schemes for urban VANETs  

 

Case Studies and Real-World Applications  
 

The proposed scheme has significant potential in various 

real-world applications, including:  

● Emergency services and disaster management: Rapid 

dissemination of emergency messages can aid in evacuation 

procedures, emergency response coordination, and alerting 

nearby vehicles about hazards or accidents. 

 ● Traffic management and congestion control: By 

efficiently disseminating traffic-related messages, such as 

traffic congestion warnings or alternate route suggestions, 

the scheme can contribute to reducing traffic congestion and 

improving overall traffic flow in urban areas.  

 

Limitations and Future Directions  
 
While the proposed scheme offers improvements in 

emergency message dissemination for urban VANETs, 

some limitations, and future directions should be 

considered:  

● Coverage and connectivity challenges: Ensuring complete 

coverage and connectivity in densely populated urban areas 

remains a challenge. Further research is needed to explore 

methods to overcome these challenges, such as the use of 

aerial networks or hybrid communication technologies.  

● Integration with other emerging technologies: The scheme 

can be further enhanced by integrating with emerging 

technologies such as 5G networks, edge computing, and 

autonomous vehicles. This integration can leverage 

additional resources and enable more efficient message 

dissemination.  

● Privacy and trust concerns: As with any communication 

system, privacy and trust are paramount. Future research 

should focus on addressing privacy concerns related to the 

collection and dissemination of vehicular data and ensuring 

secure and trusted communication channels.  

 

Methodology  
 
The methodology section presents the proposed emergency 

message dissemination scheme designed specifically for 

urban VANETs. It outlines the key components and 

principles of the scheme and explains the underlying 

mechanisms employed. Additionally, it discusses the 

selection of routing protocols and communication strategies 

suitable for urban VANETs and introduces the simulation 

tools or frameworks used for evaluating the proposed 

scheme. 
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Description of the Proposed Emergency 

Message Dissemination 

  
Scheme This subsection provides a detailed description of 

the proposed emergency message dissemination scheme. It 

explains the architecture, components, and workflows of the 

scheme, highlighting its main features and functionalities. 

The scheme may include elements such as RSUs, vehicles, 

pedestrians, and traffic management systems, along with 

their roles in the dissemination process. Additionally, the 

subsection discusses the message formats, content, and 

prioritization strategies employed in the scheme.  

 

Underlying Principles and Mechanisms  
 
This section explores the underlying principles and 

mechanisms employed in the proposed emergency message 

dissemination scheme. It discusses the principles of efficient 

routing, reliable communication, and timely message 

dissemination. The mechanisms may include intelligent 

decision-making algorithms, adaptive transmission power 

control, and dynamic network topology management. The 

discussion emphasizes how these principles and 

mechanisms contribute to improving message delivery, 

reducing latency, and enhancing overall network 

performance in urban VANETs.  

 

Selection of Routing Protocols and 

Communication Strategies  
 
This subsection focuses on the selection of routing protocols 

and communication strategies suitable for urban VANETs 

within the proposed scheme. It discusses the characteristics 

and requirements of urban environments, such as high 

vehicle density, frequent connectivity changes, and mobility 

patterns. Based on these considerations, the section explores 

the suitability of different routing protocols, such as 

geographic-based, cluster-based, or hybrid protocols. 

Furthermore, it highlights the importance of employing 

communication strategies that ensure reliable and efficient 

message dissemination in dynamic urban scenarios.  

 

Simulation Tools or Frameworks  
 
This section introduces the simulation tools or frameworks 

used for evaluating the proposed emergency message 

dissemination scheme. It may mention popular VANET 

simulation platforms like NS-3, SUMO, or Veins, along 

with their capabilities and features. The subsection also 

briefly discusses the rationale behind using simulations as 

an evaluation method, highlighting the ability to assess the 

scheme's performance under various scenarios, validate its 

effectiveness, and compare it with existing schemes.  

 

Methodology Conclusion  
 
The methodology section presents the proposed emergency 

message dissemination scheme for urban VANETs. It 

provides a detailed description of the scheme, explaining its 

components, workflows, and prioritization strategies. 

Furthermore, it discusses the underlying principles and 

mechanisms employed in the scheme, emphasizing their 

contribution to improving message delivery and network 

performance. The section also highlights the selection of 

routing protocols and communication strategies suitable for 

urban VANETs and introduces the simulation tools or 

frameworks used for evaluating the proposed scheme. By 

employing this methodology, the study aims to provide 

insights into the effectiveness and viability of the proposed 

emergency message dissemination scheme in urban 

VANETs.  

 

Performance Evaluation  
 
The performance evaluation section focuses on assessing 

the effectiveness of the proposed emergency message 

dissemination scheme for urban VANETs. It provides an 

overview of the experimental setup, including the 

parameters considered, and explains the metrics used to 

evaluate the scheme's performance. Additionally, it presents 

the performance evaluation results, including comparisons 

with existing schemes, and analyzes and interprets the 

findings, highlighting the strengths and limitations of the 

proposed scheme.  

 

Experimental Setup and Parameters 

 
 This subsection describes the experimental setup used to 

evaluate the performance of the proposed emergency 

message dissemination scheme. It outlines the simulation 

environment, including the network topology, number of 

vehicles, traffic scenarios, and density of RSUs. 

Furthermore, it discusses the parameters considered during 

the evaluation, such as message generation rate, 

transmission power levels, and mobility patterns of vehicles. 

The section also provides details on any specific 

assumptions or constraints that were taken into account 

during the performance evaluation. 

 

 Evaluation Metrics 

 
 This section explains the metrics used to assess the 

effectiveness of the proposed emergency message 

dissemination scheme. Common metrics include message 

delivery ratio, message delay, packet loss rate, and network 

coverage. The subsection discusses the significance of each 

metric and its relevance in measuring the performance of the 

scheme. Additionally, it may mention other metrics such as 

network throughput, energy efficiency, or scalability, 

depending on the objectives and requirements of the 

proposed scheme.  

 

Performance Evaluation Results  

 
This subsection presents the performance evaluation results 

of the proposed emergency message dissemination scheme. 

It includes the values obtained for the evaluation metrics 

discussed earlier. The results may be presented in the form 

of tables, graphs, or figures, providing a clear representation 

of the scheme's performance. The subsection also highlights 

any significant observations or trends observed during the 

evaluation process.  

 

Comparison with Existing Schemes  
 

This section compares the performance of the proposed 

emergency message dissemination scheme with existing 

schemes from the literature or other benchmark schemes. It 

may discuss how the proposed scheme outperforms existing 

schemes in terms of message delivery ratio, delay, or other 

relevant metrics. The comparison helps validate the 

effectiveness and superiority of the proposed scheme in 

addressing the challenges specific to urban VANETs. 
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 Analysis and Interpretation 

 

 This subsection analyzes and interprets the performance 

evaluation findings, providing insights into the strengths and 

limitations of the proposed emergency message 

dissemination scheme. It discusses the factors contributing 

to the scheme's effectiveness, such as intelligent decision-

making algorithms or adaptive transmission power control. 

Additionally, it addresses any limitations or challenges 

encountered during the evaluation, highlighting areas for 

improvement or further research. 

 

 Performance Evaluation Conclusion  
 

The performance evaluation section assesses the 

effectiveness of the proposed emergency message 

dissemination scheme for urban VANETs. It describes the 

experimental setup and parameters used, discusses the 

metrics employed to evaluate the scheme's performance, and 

presents the performance evaluation results. The section 

includes a comparison with existing schemes, highlighting 

the superiority of the proposed scheme. Moreover, it 

analyzes and interprets the findings, identifying the 

strengths and limitations of the scheme. Through this 

evaluation, the study aims to provide evidence of the 

effectiveness and potential of the proposed emergency 

message dissemination scheme in urban VANETs 

 
 

Module making  
 
1. Gather the required components: - NodeMCU 

development board (ESP8266-based) - Breadboard and 

jumper wires - GPS module (for location tracking) - GSM 

module (for sending SMS alerts) - Additional sensors or 

modules based on your specific requirements (e.g., 

temperature sensor, accelerometer, etc.)  

2. Connect the components: - Connect the NodeMCU to the 

breadboard using jumper wires. - Connect the GPS module 

to the NodeMCU's serial pins (RX and TX) for location 

tracking. - Connect the GSM module to the NodeMCU's 

serial pins for sending SMS alerts. - Connect any additional 

sensors to the appropriate pins on the NodeMCU.  

3. Set up the development environment: - Install the 

Arduino IDE on your computer. - Open the Arduino IDE, 

go to "File" > "Preferences," and in the "Additional Boards 

Manager URLs" field, add the following URL: 

http://arduino.esp8266.com/stable/package_esp8266com_in

dex.json - Go to "Tools" > "Board" > "Boards Manager," 

search for "esp8266," and install the "esp8266" board 

package. 

 4. Write the code: - In the Arduino IDE, write a program 

that reads data from the GPS module to obtain the current 

location coordinates. - Implement logic to detect emergency 

situations based on sensor readings (e.g., sudden 

temperature change, significant impact detected by the 

accelerometer, etc.). - If an emergency is detected, use the 

GSM module to send an emergency message or alert to a 

predefined list of contacts with the GPS coordinates. 

 5. Upload the code to the NodeMCU: - Connect the 

NodeMCU to your computer using a USB cable. - In the 

Arduino IDE, select the correct board and port under 

"Tools" > "Board" and "Tools" > "Port," respectively. - 

Click the "Upload" button to compile and upload the code to 

the NodeMCU.  

6. Test the device: - Power up the NodeMCU and ensure 

that all components are properly connected. - Monitor the 

device's behavior, such as GPS location tracking and 

emergency message sending, to verify its functionality. 

 

The transmitter as NodeMCU : 

 

 This is a sketch for an ESP8266 board that measures 

distance using an ultrasonic sensor and sends the reading to 

a server via Wi-Fi. The code defines the trigPin, echoPin, 

and ledPin, sets up the Wi-Fi connection, and then enters the 

main loop. Inside the loop, the code first sends a pulse to the 

trigPin to start the ultrasonic sensor, and then measures the 

duration of the echo using the pulseIn() function. Using the 

duration and the speed of sound, the code calculates the 

distance to an object in front of the sensor. The code then 

checks if the distance is less than or equal to 10 cm. If it is, 

it turns off the LED connected to the ledPin and sets 

sensorValue0 to 0. Otherwise, it turns on the LED and sets 

sensorValue0 to 1 after a delay of 5 seconds. The code then 

creates a TCP connection to a server specified by the IP 

address and port number. It constructs a URL with the 

sensor readings and sends a GET request to the server with 

the URL. Finally, it waits for a response from the server, 

times out if it takes too long, and stops the connection. It's 

worth noting that this code has some limitations and could 

be improved. For example, it only measures the distance to 

a single object in front of the sensor and sends only one 

reading to the server per loop iteration. It could also benefit 

from error handling and more robust Wi-Fi connectivity. 

 

A receiver as NodeMCU :  
 
This is a sketch of an ESP8266 microcontroller that is 

connected to a relay module. The code receives sensor 

readings via an HTTP GET request to the server's "/data/" 

endpoint. It then deserializes the received JSON data to 

extract four sensor readings and stores them in the 

sensorValue0, sensorValue1, sensorValue2, and 

sensorValue3 variables. The toggle_relays() function checks 

the values of the four sensor readings and turns the relay on 

or off accordingly. If a sensor reading is 0, the relay is 

turned off, and if it's 1, the relay is turned on. The relay is 

connected to the relay in pin, which is set to output mode in 

the setup() function. The code also sets up an access point 

with the SSID "wifi" and password "auto-connect" using the 

WiFi.softAP() function. It then listens for HTTP requests on 

port 80 using the server.begin() function and responds to 

requests to the "/data/" endpoint by calling the 

handleSentVar() function. Overall, the code seems to be 

designed to receive sensor readings and control a relay 

based on those readings. However, there is no information 

provided on the sensor types, how they are connected to the 

ESP8266, or how the readings are being transmitted to the 

server. 
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Application 

 The application of the described device using NodeMCU 

and other sensors for emergency message dissemination in 

urban VANETs is to detect and transmit emergency alerts or 

messages in real-time to notify relevant parties about critical 

situations or incidents. The device operates as follows: 1. 

Sensors: - The device incorporates various sensors such as a 

GPS module, temperature sensor, accelerometer, or any 

other relevant sensor based on the specific emergency 

detection requirements. - These sensors continuously 

monitor the environment and gather relevant data. 2. 

Emergency Detection: - The sensor data is processed and 

analyzed in real-time to detect emergency situations. - For 

example, the temperature sensor might detect a sudden rise 

in temperature, indicating a fire or the accelerometer might 

detect a significant impact, indicating a collision. 3. GPS 

Location Tracking: - The GPS module retrieves the device's 

current location coordinates. - This information is crucial 

for accurately reporting the location of the emergency 

incident. 4. Emergency Message Generation: - Upon 

detecting an emergency situation, the device generates an 

emergency message. - The message includes essential 

information such as the type of emergency, location 

coordinates, severity, and any recommended actions. 5. 

GSM Module for Message Transmission: - The device 

utilizes a GSM module for sending the emergency message. 

- The GSM module is capable of sending SMS alerts, 

making it suitable for communication in areas with cellular 

network coverage. 6. Message Transmission: - The 

emergency message, including the relevant information, is 

sent via SMS to predefined contacts or a centralized 

emergency response system. - The message can be 

transmitted to authorities, emergency services, nearby 

vehicles, or any other relevant parties who need to be 

informed about the emergency. 7. Real-time Updates and 

Notifications: - The device can continuously monitor the 

emergency situation and provide real-time updates or 

notifications. - This allows for ongoing communication and 

sharing of critical information with the recipients to 

facilitate an appropriate response. By combining sensor 

capabilities, GPS location tracking, and GSM 

communication, the device can promptly detect 

emergencies, gather crucial information, and transmit it to 

the necessary parties in real time. This enables faster 

response times, enhances situational awareness, and aids in 

coordinated emergency management within urban 

VANETs. 

 

Discussion  
 
The discussion section examines the implications of the 

research findings in the context of emergency message 

dissemination in urban VANETs. It addresses any 

limitations or challenges encountered during the research 

process and provides insights and recommendations for 

further improvements and future research directions. 

 

Implications of Research Findings  
 

This subsection explores the implications of the research 

findings in the context of emergency message dissemination 

in urban VANETs. It discusses how the proposed scheme 

contributes to addressing the challenges specific to urban 

environments, such as high vehicle density, dynamic 

mobility patterns, and limited communication range. The 

discussion highlights the positive impact of the scheme on 

message delivery ratio, delay, and overall network 

performance. Furthermore, it emphasizes the potential 

benefits of the scheme in enhancing incident management, 

improving safety, and reducing congestion in urban areas. 

 

Addressing Limitations or Challenges  
 

This section addresses any limitations or challenges 

encountered during the research process. It acknowledges 

and discusses factors that may have affected the 

performance or generalizability of the proposed emergency 

message dissemination scheme. For example, limitations 

could include the assumptions made during the simulation, 

constraints of the evaluation environment, or specific 

scenarios that were not adequately considered. The 

subsection also proposes potential strategies or areas of 

improvement to overcome these limitations, such as 

incorporating more realistic mobility models, considering 

real-world traffic conditions, or addressing the impact of 

malicious attacks. 

 

Insights and Recommendations 

 
 This subsection provides insights and recommendations for 

further improvements and future research directions in the 

field of emergency message dissemination in urban 

VANETs. It identifies potential areas of exploration based 

on the research findings and the limitations encountered. 

For instance, it may suggest investigating advanced routing 

protocols that can handle highly dynamic urban scenarios or 

incorporating machine learning techniques to optimize 

message dissemination based on traffic patterns. The 

discussion also encourages collaboration between academia, 

industry, and government agencies to address the challenges 

of deploying and integrating the proposed scheme in real-

world urban environments. Furthermore, it recommends 

conducting field trials or pilot projects to validate the 

effectiveness of the scheme in practical settings and explore 

its interaction with existing infrastructure and traffic 

management systems. 

 

Conclusion 

 
 In conclusion, the proposed intelligent routing scheme for 

emergency message dissemination in urban VANETs 

addresses the challenges posed by high vehicular density, 

frequent topology changes, and limited communication 

range. By utilizing vehicular traffic information, predictive 

routing algorithms, and adaptive message forwarding 

strategies, the scheme improves the message delivery ratio, 

reduces propagation delay and enhances scalability and 

efficiency. Real-world applications include emergency 

services, disaster management, and traffic management. 

While further research is needed to overcome coverage 

challenges and address privacy concerns, the proposed 

scheme holds promise for enhancing emergency message 

dissemination in urban VANETs. 
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